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Youth Photography - Week One 
Instructor: Roger Buchanan         These notes are at www.thenerdworks.com 

Camera Shooting Skills 
Image Capture Setting – Aperture, Shutter Speed, ISO are set differently in AUTO, SCENIC and MANUAL modes. 
Shutterlag – Press the shutter button part way down to focus, hold until ready, then press all the way to take picture. 
Panning – Focus on subject with part press of shutter button, camera follows subject, take picture as camera moves. 

Camera Information Activities 

Colour Skills Test – PDF Can how we see colours be influenced by the colours we see? 

Camera Types- PDF What qualities do the different camera types have? 
MetaDATA - PDF What is a digital photography really made up of, and why should we care? 
Losing Photographs – PDF What can happen to our digital photographs? 
3,2,1 – Backup – PDF How can we keep our digital photographs safe for future generations to enjoy? 

Camera Menu Settings 

Date. & Time – This is the main method by which computers organize files 

File naming – Reset or Continuous? Unless you are a working photographer set to CONTINUOUS 
Format - memory cards with the camera before using, and ONLY with the camera 
Resolution set to maximum quality & detail – it is easy to make images smaller, very hard to make them larger 

Camera Control Buttons 

 Playback button – used to review an image that you have already taken 

Enlarge button – helpful to review details,  Reduce button – great for seeing images in groups 

 ISO – image brightness control, higher numbers create brighter images but risk adding grainy “noise” 

Flash – adds additional light to photograph but also can create red-eye. 

 Self-timer – time delay for shutter release 

 Drive Mode – taking many photographs in very quick order. 

Macro – for taking detailed photographs very close to subjects 

  Trashcan (Delete) Using it leads to fragmentation of your memory card and lousy performance. Don’t use it!  

White Balance     

Homework: Signs – take 1 image of each type of sign: Icon, Index, Symbol 
Icon Index Symbol 

      

Resembles Implies Learned 

Do your homework Dagnabbit!  That means I’m serious!  Bold means REALLY SERIOUS  

 

http://www.thenerdworks.com/support/classes-notes/


Click! 

One Step Press 

Cause of delays 

Click? 

Two Step Press 

Use this Method 

 

Focus 

Measures Light 

Adjust Exposure Settings 

White Balance 

Prepares to write file Data 

Takes Picture! Takes Picture! 

Shutter Lag is the delay caused when you try and take a picture with one big press of the shutter button. 

ISO 

100—6400+ 

Image  

Capture 

Image Capture settings 
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Aperture affects Depth of Focus. 
NOTE: Each of the below photographs is properly exposed, and yet each photo was taken with different Aperture and 

Shutter Speed settings These four photographs are examples of what are said to be “Equivalent Exposures” (i.e. 

Properly exposed, but made with different settings) 

 f/16  

 f/8  

 
f/2.8   

 f/1.8  
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Aperture and Shutter Speed Depth of Focus versus Motion Blur. 
Aperture and Shutter Speed Aperture and Shutter Speed 

 

f/16@ 1/4 sec 

 
The Blue object is completely blurred and all the 
objects are in focus. 

 

f/8 @ 1/13 sec 

 
The Blue object is only slightly less blurry, yet 
the Depth of Focus is getting shallower. 

 

f/2.8 @ 1/100 sec 

 
The Blue object is getting some real revealing 
shape and the Depth of Focus in much 
shallower. 

 

f/1.8 @ 1/250sec 

 
The Blue object is revealed as a Pin Wheel and 
only the second figure is still in focus, the Depth 
of Focus is not extremely shallow. 

NOTE: Each of the above photographs is properly exposed, and yet each photo was taken with different Aperture and 

Shutter Speed settings. These four photographs are examples of what are said to be “Equivalent Exposures”  

(i.e. Properly exposed, but made with different settings) 



Week TWO: Intro to Digital Photography 

Judge Your Colour Interpretation Skills. 

   

   

   

   

   

   

 

 

 

How many specific colours do you see? ________________ 



Colour Interpretation. 
 

   

   

   

   

   

   

 



Camera Designs: 
Compact Point and Shoot: Small and self-
contained camera with few accessories. 

 
Least expensive system 

Hybrid Point and Shoot: Larger but still an all-
in-one, totally self-contained, but with more 
performance and accessories. 

 
More expensive system 

Mirrorless ILC: (Interchangeable Lens Camera) 
Camera with separate lens that does NOT use a 
mirror viewfinder system. 

 
Still more expensive system 

Digital SLR: Camera body with separate lens, 
most capable style of all consumer cameras. Most 
costly, with most accessories.  Uses mirror 
viewfinder system. 

 
Most expensive system 

Mirror Viewfinder System vs Mirrorless Design 

 
In a dSLR the mirror swings up out of the way when the photo is made 

 



What Makes a Digital Photograph 



Losing Photographs © thenerdworks.com All Rights Reserved 2016 Page 1 
 

Losing Photographs: Film vs Digital Loss 
Regular 3,2,1 Backups and Prints are your safest way of protecting your treasured photographs! 

  
Print from the early 1970’s has faded slowly. Print scanned and “Restored” to correct the flaws. 

  
A digital image that was corrupted. Lost instantly. 
No hope of being “restored”. 
 

The image, recovered from a backup. Backups 
need to be done regularly & need to be validated! 



3,2,1...Backup strategy 

3 Copies of every  photograph 

2 different types of storage media 

1 set photos at different location 

(Prevents loss from obsolescence of technology)



White Balance Colour Settings 
Our eyes adjust to the colour of light shining on a subject, the camera needs to be told the type of light. 

  

Auto Daylight 

  

Cloudy Shade 

  

Tungsten Fluorescent 

 

 
TIP: Regarding AWB (Auto White Balance) 
AWB “calculates” what it thinks is the correct White 
Balance each time you take a photograph. When taking 
many pictures *of the same subject* AWB may 
calculate White Balance differently between shots, 
thereby altering the colour of your subject slightly. So 
use a *specific* WB instead! 

Flash  
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Youth Photography: Week Two 
Homework: Signs – take one image of each type: Icon, Index & Symbol 

Manual Modes – P, A, S, M   
 
 
Auto Mode: the camera makes 
all the decisions about how to 
get the best exposure. 
 
 

 

Scenic Modes: the camera 
chooses the best settings based 
on a “recipe” for that type of 
subject. 

   
Using Manual Modes: ACTIVITY – the modes in brackets are for use with Point & Shoot cameras 

A or Av = Aperture Priority mode 
(Portrait)                                      (Landscape) 

 S or Tv = Shutter Priority mode 
(Night time)                                    (Sports) 

 

Aperture affects 
Depth of Focus 

 

 30 sec Shutter Speed is 
how motion is 
captured 

1/8000th sec 

  Shallow      Deep     

       

       

   ISO    

  100 Controls 
brightness 

3200   

  In bright 
light 

 Darker 
places 

  

 

 ISO – image brightness control, higher numbers create brighter images but risk adding grainy “noise” 

Flash – adds additional light to photograph but also can create red-eye. 

 Self-timer – time delay for shutter release 

 Drive Mode – taking many photographs in very quick order. 
 

White Balance     White balance matches the light for accurate colour in your photo. 
 
Activity: Take a photo of your partner using each of the white balance setting (but NOT CUSTOM) 
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Cropping vs Zooming: is the choice you make of how to isolate your subject from the background 

elements. However, both cropping and zooming have their strengths and weaknesses.  

Activity: From a medium distance use zoom on your subject so that they almost fill the frame. Next, 

reduce the zoom completely and move the camera (cropping) closer to the subject to obtain the same 

framing. Compare how the photos each affect the shape of your subject at the different zooms 

Panning: Refers to focusing on your subject and following their movement while you take the photo. 

This keeps your subject sharp and shows the effect of motion by blurring the background 

Activity: Put your camera in “S” or “Tv” mode. Use a shutter speed between ¼ & 1/15th of a sec at ISO 

100. Make sure to keep the camera moving evenly aligned with the subject while you take the photo 

(i.e. follow-through) 

Perspective: Perspective refers to how you show the shape of a subject. “One-Point” perspective just 

shows one side of an object, “Two-Point” shows Two sides, and “Three-Point” Three sides.  

Activity: Use the box provided, with different coloured dots on each side, to capture an image in “One-

Point” perspective (ONLY ONE dot is visible). Then continue to take another image in “Two-Point” (ONLY 

TWO dots are visible) , then “Three-Point” perspective (THREE DOTS visible) 

Shadow Details: The angle of light shining on a subject affects how the details of the subject are seen.. 

Activity: Using the flashlights and sponge cubes provided photograph the cubes from many different 

lighting angles. (Keep your camera in ONE POSITION ONLY and move the flashlight around) 

Manual Focusing: Low Light 

dSLR or Mirrorless 

 

Usually it’s a sliding switch found on the side of the lens. 

Point & Shoot or Hybrid 

 

Usually shown on the back of the camera as “MF”. 
Sometimes you may need to go into the camera menu. 

 

Painting with Light: In a low light situation you can add artificial light. 

Activity: Set your camera in Shutter Priority at 6 seconds (6”) and ISO 100. Have your subject sitting, 

trigger the shutter, and then quickly illuminate them by shining the constantly moving light on them. 

Light Trails: Make photographs with a moving light source! 

Activity: Set your camera in Shutter Priority at 6 seconds (6”) and ISO 100. One person at a time only! 

Slip the glow stick onto string. Crack the glow stick and shake it until bright. Start the glow stick spinning 

and then have the other people take the picture. 
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Youth Photography Week Three 

Guest Speaker: Mercedes Young - Photographer 

ACTIVITY:  Pet Interview 

 
Pretend that you are your pet and have someone ask you the following. 

 

What is your Name? ___________________________________________________ (Important for voice cues)  

Age? ________________Yrs. 

What Breed are you? _____________________________________________________________________ (Important for historical context) 

Do you have a favourite Toy?____________________________________ Treat?_________________________________________________________  

Can you do any Tricks? ____________________________________________________________________________________________________________ 

What Commands do you respond to? _____________________________________________________________________________________________ 

At what times are you most Active? ______________________am/pm Resting? ______________________am/pm 

Do you have a “special place” where you go to Rest/Relax/Hide? _____________________________________________________________ 

Do you have any “Unique” behaviour that you are known for? _________________________________________________________________ 

Are you “Notorious” for any type of Bad behaviour? ____________________________________________________________________________ 

Are you patient or easily startled? ______________________________________ (important for time/noise constraints) 

Do you have any special animal friends? _________________________________________________________________________________________ 

What about people friends? _______________________________________________________________________________________________________ 

After you have eaten, are you more relaxed, or do you get playful? ___________________________________________________________ 

What is a favourite Activity of yours? _____________________________________________________________________________________________ 

What is your signal that you are getting cranky and want to be left alone?____________________________________________________ 
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ACTIVITY: Perspective 

Take photos with One, Two and Three Point perspective using the supplied cardboard boxes 

 

ACTIVITY: Photographing “The Pet”. (remote controlled pet) 

Set your camera to: Shutter Priority (1/125th second) or Action mode. 

Make the following images of the moving subject: 

• Panning; 

• Spot Focus – focus on a spot on the floor in advance and take the shoot when the pet passes by; 

• Point of View – take shots from different camera positions. 

 Above 

 Side 

 Head on 

 Rear 

 

ACTIVITY: Accessories: - Show and Tell 
 
List the ones you’d like: 
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Youth Photography Week Four: Editing 
 

All of these edits were done using Photoshop Elements 2020 

Demo laptop is 2GHz i7 with 16GB Ram and twin Solid State Drives and is used to demo video editing. 

Sit at the same distance from the monitor with the room lighting at the same level of brightness. 

If using a laptop keep the screen at the same distance, brightness, and the same angle. 

Calibrate your monitor every couple of weeks for color accuracy (watch demo). 

Do NOT edit jpep’s! Change them to an editing friendly file like a PSD or Tiff first using the command “Save As…” 

Colour Theory: 

Additive Colours (Colours recorded by your camera) Red Green Blue  

 
 
 

   
 

 

Subtractive Colours (Colours made with the Ink in your Printer) Cyan Magenta Yellow Black 

Remove a colour by adding the opposite colour. Create a colour by adding the two not directly across from colour. 

Skill Description 
Remove a Person 
 

Save Image as a PSD and work on a background copy. Select, Erase and Clone. 
 
 

Background change 
 

Save Image as a PSD and work on a background copy. Go to Guided, Special Edits, Replace 
Background. 
 
 

How to make Layers 
for different things 

Save Image as a PSD and work on a background copy. From the Menu bar click on “Layer”, 
chose the type of Layer you want. 
 
 

Special Effects and 
Filters 
 

Save Image as a PSD and work on a background copy. Go to the menu bar and click on 
“Filter”, then choose the filter. Adjust layer strength by adjusting “Opacity”. 
 
 

Funny Editing 
 

Save Image as a PSD and work on a background copy. Just play with Filters and various Tools. 
 
 

Face Editing 
 

Save Image as a PSD and work on a background copy. Spot Healing or Spot Healing Brush to 
remove blemishes, and control the strength of the edit by adjusting the “Opacity” slider. 
 

Make an image Scary Save Image as a PSD and work on a background copy. Search the internet for parts of an 
image in the “png transparency” format. These will have a white/grey checkerboard 
background which lets the rest of your image show through as you build it. 
  

These techniques and more are in the PDF notes online at www.thenerdworks.com 
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“Photo Editing” – Tips for Processing Outlined 
NOTE: In many cases there is more than one way to do a similar adjustment.  

 

Key Combinations to Remember: 
Ctrl+Z is UNDO Spacebar is SCROLL HAND Tool TAB is Show/Hide Panels 
D is set colours to default X is Switch colours  

 

The following is a list of “How To…” editing descriptions. 

Process a “RAW” file 
 Select the RAW file 

 Click on the “Editor” icon in the toolbar at the bottom of the screen & Camera RAW opens 

 At the bottom of screen “Depth” select 16 Bits/Channel 

 Turn on “clipping warning” by clicking on the two triangles in the top of the Histogram 

 Start with the White Balance slider at the top right and work your way down 

 Click on the Details Tab just below the Histogram 

 Adjust Colour Noise & then Colour detail 

 Adjust Luminance Sliders going top to bottom 

 Increase the View to 100% 

 Apply Sharpening settings for Amount (125), Radius (1) and Detail (as needed) 

 Hold the “Alt-key” and Adjust Masking slider to affect only the Edges in your image 

 Click on “Open Image” to continue editing in Photoshop Elements. 

Properly work on a jpeg image: 
 Open jpeg file 

 Go to File>Save As> and choose “psd” from the file format drop down list, Click “Save” 

 Edit and adjust your photo as you want 

 ONLY when you are finished do you go To File>Save As… and choose jpeg. 

Crop Image to Size:         In the Editor, select the Crop tool (C) 
 If you want to use a resolution other than that of the original photo, select one of the following options from the 

Aspect Ratio menu or specify new custom values in the Width and Height boxes in the options bar 

 No Restriction Lets you resize the image to any dimension 

 Photo Ratio Displays the original aspect ratio of the photo when you crop. The Width and Height boxes show the 

values that are used for the cropped image. The Resolution box allows you to change the image resolution 

 Preset size Specifies a preset size for the cropped photo. If you want your final output to be a specific size, such as 4 

x 6 to fit a picture frame, choose that preset size 

 Note: When you specify values for the Width and Height boxes, the Aspect Ratio menu changes to Custom 

 Drag over the part of the image you want to keep. When you release the mouse button, the crop marquee appears 

as a bounding box with handles at the corners and sides 

 Click the green Commit button to finish the cropping or click the red Cancel button. 
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Add More Canvas to Photo with the Crop tool: 

 Select Crop tool ( press C) make small crop area, DO NOT press Enter or click OK just yet 

 Drag the corner “handles” outside the image area to add canvas 

 Now press ENTER to finish. 

Straighten Horizons:      In the Editor, select the Straighten tool (P).  
 To straighten all of the layers in the image, select Rotate All Layers, and then choose an option from the Canvas 

Options menu (this menu is available only if you select Rotate All Layers) 

 Grow or Shrink Canvas To Fit Resizes the canvas to fit the rotated image. Straightening causes corners of the 

image to fall outside of the current canvas. The straightened image will contain areas of blank background, but 

no pixels are clipped 

 Crop To Remove Background Crops the image to remove any blank background area that becomes visible after 

straightening. Some pixels will be clipped 

 Crop To Original Size Keeps the canvas the same size as the original image. The straightened image will include 

areas of blank background and some pixels will be clipped. Do one of the following to straighten the image 

 To align horizontally, draw a line in the image to represent the new straight horizontal edge 

 To align vertically, hold down Ctrl and draw a line to represent the new straight vertical edge. 

Do Basic Exposure Adjustment with Layers:   
 In the Layers palette, select the topmost layer you want to affect 

 To affect all the layers below the adjustment layer, click the Create Adjustment Layer button at the top of the Layers 
palette, and choose one of the following adjustment types. (The first three options in the menu are fill layers, not 
adjustment layers.)  

• Levels Corrects tonal values in the image. 

• Brightness/Contrast Lightens or darkens the image. 

• Hue/Saturation Adjusts colors in the image. 

Exposure Issues  
Underexposed  
 Click on Image “Layer” 

 Ctrl-J to duplicate layer, blend mode = Screen 

 Ctrl-J to duplicate screened layer, repeat as necessary, adjust opacity to taste. 
 

Overexposed  
 Click on Image “Layer” 

 Ctrl-J to duplicate layer, blend mode = Multiply 

 Ctrl-J to duplicate screened layer, repeat as necessary, adjust opacity to taste.  

Open Shadows  
 Enhance>Adjust Lighting>Shadows/Highlights, Lighten Shadows = 25%  

Dodge and Burn  
 Alt-click new layer icon  

 Mode = Overlay and check Fill Overlay Neutral Gray 50%, Click OK, a new layer filled with Gray is added; 

 “B” for Brush tool, med size, soft edge, 15% Opacity, Press “X” to set colours to Foreground White 

 Paint on area to highlight (Dodge) Strength of effect is controlled by Brush Opacity 
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 To darken press “D” to make Black foreground colour and paint areas to be darker.  

Subject is too Dark  
 Click on Image “Layer”; 

 Ctrl-J to duplicate layer; 

 Enhance > Adjust Lighting > Levels > midtone slider goes to left; 

 Ctrl-click create new layer; 

 Click top layer, Ctrl-G  

 Click Blank layer, “B” for brush, Soft edge; 

 “D” for foreground colour, paint areas to lighten  

 Adjust opacity to taste.  

Edge Contrast Enhancement 

 Duplicate Background Layer (Ctrl+J) 

 Apply large Gaussian Blur 

 Set duplicate layer blend mode to Difference (Shift + Alt + E) 

 Stamp/Merge Visible (Ctrl+Shift+Alt+E) 

 Turn OFF the visibility of the blurred layer 

 Invert the merged copy (Ctrl+I), set blend mode to Colour Burn 

 Add Hue/Saturation layer as needed. 

Quick Selection Tool  
 Open Image, “A” for Quick selection tool; 

 Check box “Auto-Enhance” = ON 

 Paint squiggle on selection, Alt-click to remove areas 

 Make adjustment, then Ctrl-D to deselect.  

Make Selections with Brush  
 “A” for Selection Brush, soft edge brush 

 Click on Image “Layer” 

 Click and drag to paint selection, Alt-click to deselect areas, Alt+S, F, Feather Radius = 15 to soften edges. 

Irregular Shaped Selections  
 “L” key to get Magnetic Lasso tool, trace along edge, if you miss an edge “backspace” and try again.  

Smooth Selection Edges  

 Select->Refine Edge->Adjust Edge-> Smooth 

Extract Object from Image  
 Open Image, “A” for Quick Selection 

 Paint over object to extract, Alt-click to remove, “Z” = zoom tool 

 Open New image, “V” for move tool, Ctrl-T for Free Transform 

 Hold Shift and drag corner to resize, “Enter” to commit.  

 Make selection, then Select > Feather 5 pixels. 
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Select by Colour: 

 Choose Magic Wand ( Press A) check off a) anti-alias and b) contiguous 

 Click in coloured area of choice 

 Shift+Click to add areas to selection; (if not enough is selected increase the “tolerance” option.) 

 To change the selected area of colour Press Ctrl+U 

 Change the colour and press OK 

 Press Ctrl+D to deselect. 

Remove Dust and Marks:     In the Editor, select the Healing Brush tool . 
 Choose a brush size from the options bar and set healing brush options 

 Mode Determines how the source or pattern blends with existing pixels. Normal mode lays new pixels over the 

original pixels. Replace mode preserves film grain and texture at the edges of the brush stroke 

 Source Sets the source to use for repairing pixels. Sampled uses pixels from the current image. Pattern uses 

pixels from the pattern you specify in the Pattern palette 

 Aligned Samples pixels continuously without losing the current sampling point, even if you release the mouse 

button 

 Deselect Aligned to continue using the sampled pixels from the initial sampling point each time you stop and 

resume painting 

 Sample All Layers Samples data from all visible layers. Deselect Use All Layers to sample only from the active 

layer 

 Position the pointer in any open image and Alt-click to sample data 

 Note: If you are sampling between images then both images must be in the same color mode 

 Drag in the image over the flaw to meld existing data with sampled data. The sampled pixels are melded with 

the existing pixels each time you release the mouse button. 

Clone parts of Image:   In the Editor, select the Clone Stamp tool .  
 (Optional) Set options in the options bar 

 Brushes pop-up menu Sets the brush tip. Click the arrow next to the brush sample, choose a brush category 

from the Brushes pop-up menu, and then select a brush thumbnail 

 Size Sets the size of the brush in pixels. Drag the Size pop-up slider or enter a size in the text box 

 Mode Determines how the source or pattern blends with existing pixels. Normal mode lays new pixels over the 

original pixels 

 Opacity Sets the opacity of the paint you apply. A low opacity setting allows pixels under a paint stroke to show 

through. Drag the pop-up slider or enter an opacity value 

 Aligned Moves the sampled area with the cursor as you begin to paint, regardless of how many times you stop 

and resume painting. Selecting this option is useful when you want to eliminate unwanted areas such as a 

telephone line across the skyline or a rip in a scanned photo. If aligned is deselected, the Clone Stamp tool 

applies the sampled area from the initial sampling point each time you stop and resume painting. Deselecting 

this option is useful for applying multiple copies of the same part of an image to different areas within the same 

image or to another image 

 Sample All Layers To sample (copy) data from all visible layers, select Use All Layers. To sample data from only 

the active layer, deselect this option 

 Position the pointer on the part of any open image you want to sample, and Alt-click. The tool duplicates the 

pixels at this sample point in your image as you paint 

 Drag or click to paint with the tool. Clone from similar area and sample often to avoid patterns repeating. 
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Free Transform a Selected Object 
 Duplicate Layer 

 Select item in Duplicate Layer 

 Press - Ctrl-T 

 Drag Bounding box to resize Item 

 Position Item 

 Click the Okay Arrow or Cancel 

 Use Eraser tool to clean up margins of transformed selection. 

Do A Panorama  
 Tripod, Aperture priority, 30% overlap, name shots in order  

 Edit >Photomerge > Photomerge Panorama  

Add Text to Image:   the Horizontal Type tool or the Vertical Type tool . 
 To create a single line of text, click in the image to set an insertion point for the type 

 To create paragraph text, with the Text tool drag a rectangle to create a text box for the type 

 The small line through the I-beam marks the position of the type of baseline. For horizontal type, the baseline 

marks the line on which the type rests; for vertical type, the baseline marks the center as of the type characters. 

(Optional) Select type options, such as font, style, size, and color, in the options bar.); 

 Type the characters you want. If you did not create a text box, you can press Enter to create a new line.; 

 The text appears on its own layer, which is called a type layer 

 Commit the type layer by doing one of the following 

 Click the Commit button in the options bar 

 Press the Enter key on the numeric keypad 

 Click in the image, outside of the text box. 

Gray Skies are going to clear up!  
 “W” for Magic Wand tool to select sky  

 “L” for Lasso tool and alt-click to UN-select extra areas  

 Open image with good sky and Ctrl-C to copy  

 Go to original image, New Layer, Edit > Paste into Selection  

 Ctrl-D to deselect and adjust Opacity to taste.  

Neutral Density for Sky  
 Open landscape and press “D” foreground colour Black; 
 Layers palette > Create Adjustment Layer > Gradient, Dbl-click 2nd Gradient “Foreground to Transparent” 
 Click “Reverse” checkbox, Click OK 
 Layer Blend Mode = Overlay, Adjust Layer Opacity to taste 

Sharpening  
 View at 100% for sharpening!  

 Click Enhance > Unsharp mask (Alt-N, Unsharp Mask) 

 Apply settings based on Image Content (see “Workflow Outline: Photo Style of Sharpening”) 

 Amount = Amount of sharpening applied 

 Radius = How many pixels out from edge sharpening affects 

 Threshold = how different a pixel must be to be called and EDGE pixel 
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Extra Fine Detail Sharpening  
Step 1. Sharpen image 

Step 2. Click on Image “Layer” 

Step 3. Ctrl-J to duplicate image 

Step 4. Ctrl-F to apply same sharpening to image 

Step 5. Ctrl-click on Create New Layer icon 

Step 6. Click on over sharpened layer and press Ctrl-G to group it 

Step 7. “B” and soft edge brush, “D” for foreground to black 

Step 8. Click on blank layer and paint areas to sharpen.  

Luminosity Sharpening  
Step 1. Open Image;  

Step 2. Click on Image “Layer” and Ctrl-J;  

Step 3. Enhance > Unsharp Mask, Apply settings;  

Step 4. Layer blend Mode = “Luminosity”, Flatten image.  

Edge Sharpening  
Step 1. Open Image 

Step 2. Click on Image “Layer” 

Step 3. Ctrl-J to duplicate 

Step 4. Filter > Stylize > Emboss 

Step 5. Angle and Amount at default, Increase Height 

Step 6. Layer Blend mode to Hard Light, use Opacity to taste.  
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Workflow Outline Using “Camera RAW” 
 

In Camera RAW click on the “preview” box, and activate the Clipping warning triangles above the histogram. 
 

Order Task 
Crop and Align Image from toolbar  

BASIC TAB 
White Balance: 
Use one of these 
three options. 

a) As Shot – Drop Down List Notes: Temperature balances Cyan – Yellow,    Tint balances 
Green – Magenta b) Eye Dropper Tool – Click on Grey 

c) Temperature & Tint Sliders 

Exposure: Notes: Be sure to activate the Highlight/Shadow warnings by clicking on the black triangle above the 
Histogram. 
“Alt-click” the exposure slider to get a better view of the clipping area 

DETAIL TAB – View Image at around 300% for Noise Reduction (3rd Party Plug-ins Rule!) 
Luminance: Notes: This reduces the blotchy noise found in shadow areas of the image. Detail slider preserves detail. 

Colour: Notes: This reduces all other types of noise. Detail slider protects fine coloured detail edges. 

BASIC TAB - in the order to be used (not as displayed in Camera RAW) 
Contrast: Notes: Increasing contrast will highlight detail but will also increase colour saturation. 

Blacks: Notes: Drag right to lighten blacks. In a washed out photo use this before the exposure slider.  
Use of Blacks slider often causes colours to have an increase in saturation. 

Shadows: Notes: Adjusts the darker pixels, but not the blacks, and can recover detail in the shadow areas. 

Whites: Notes: Use this AFTER Exposure/Blacks adjustments 

Highlights: Notes: Do your “Whites” adjustment first! 

Clarity: Notes: Adds “Pop” to the image by increasing only mid-tone contrast. 

Vibrance: Notes: Saturates the pale colours much more than the already vivid colours, and mostly leaves skin tones 
alone. 

Saturation: Notes: Saturation is best done “modestly” staying under 15% 

DETAIL TAB – View Image at 100% when Sharpening 
Stage Task 

Amount: Notes: Controls how strong the sharpening will be applied. Shown as a percentage, with 100% a 
recommended starting value 

Radius: Notes: Controls the size of the edges you sharpen, a smaller radius value sharpens smaller-scale detail. The 
smaller the detail in your image the smaller you set the starting Radius value. 

Detail: Notes: Avoid Sharpening Halos, “Alt-click” the slider to get a better view. 
Controls the relative sharpening of fine versus coarse detail (within a given radius value) Higher values 
emphasize fine detail, but also increase the overall sharpening effect. You will likely need to adjust this 
setting in conjunction with the amount/percent setting. 

Masking: Notes: Drag right to reduce sharpening on non-edge areas, also works with the “Alt-click” technique. 

Open Image: Notes: Click on “Open Image” button to have image open in the Photoshop Elements Editor. 
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Regular Image Workflow Outline 
Camera RAW (if needed) Process RAW files Process steps from Top to Bottom 

Notes: Photoshop Elements will not let you do a lot of editing while the file is still in 16-bit mode. When you are done 
processing the RAW file to change the file to 8-bit mode click “Open Image” then click Alt+I, M, A. 

Basic Edits Save as Photoshop File File> Save As> Format> down arrow select “PSD” 

Reduce Bit-Depth from 16 --> 8 Image, Mode, 8-Bits/Channel 

Align Horizon 
Straighten Tool (P)  

Crop 
Crop Tool (C)  

Notes: 
Remember to Align before Cropping so you won’t have to Crop a second time. 

Global Edits: Full Adjustments Adjust Exposure Blend Mode: Multiply = Darken, Screen = Brighten 

Notes: You control the strength of the adjustment using the Opacity slider. 

Local Edits: Adjust Select Area Tone Contrast Colour Saturation 
Alt+L, New Adjustment Layer, or   

Dodge, Burn or Sponge 

O  

Notes: Adjustment Layers come with a Mask, which allows them to be selectively applied 

Clean & Retouch Click  “Expert” Healing Brush 

J  

Clone Stamp 

S  

Notes: Remember to sample by “Alt+Clicking” and use several short brush strokes. 

Special Effects Selection Tool 

a  

Transform Tool 

 Ctrl + t  

Notes: Apply Special effects by using these tools on specific parts of the image. 

Add Border Crop a small box INSIDE image, then Drag handles  OUTSIDE of image 

Notes: The colour of the border will be the current foreground colour indicated. 
 

Add Text Select Text tool, font, size 

 
Click tool on image and enter text  

Notes: Do NOT resize the photo after adding the Text to the Image. 

Output Sharpen Alt+N, Unsharp Mask…Enter 

Get Creative with the Image!  

Notes: For sharpening there are some things to know. 
Photo Style of Sharpening Amount % Radius pixels Detail 

Average 125 1  
 

Adjust Detail to your Taste 
 

View Image at 100% while adjusting 
 

Soft fuzzy subjects 150 1 

People up close 75 2 

Medium Scenic’s 225 0.5 

Edges, lots of edges 65 4 

General Purpose 85 1 

Web at 72ppi 400 0.3 

DIY 50-150 1-2 
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